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DAVID-LINK LEGAL ISSUES 
 

 

Information in this document is subject to change without notice. The names of companies, products, people, 

characters, and/or data mentioned herein are fictitious and are in no way intended to represent any real individual, 

company, product, or event, unless otherwise noted. Complying with all applicable copyright laws is the 

responsibility of the user. No part of this document may be reproduced or transmitted in any form or by any means, 

electronic or mechanical, for any purpose, without the express written permission of David-Link Corporation. 

David-Link may have patents, patent applications, trademarks, copyrights, or other intellectual property rights 

covering subject matter in this document.  

• All software modules come with a software protection device. This device is free and comes with a full 

replacement warranty if found defective. When lost, the replacement cost for this device will be equivalent 

to the value of the software purchased. The CLIENT shall assume full responsibility in safeguarding.  

• The CLIENT may not take unauthorized copies, reverse engineer, or decompile the SOFTWARE. 
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INTRODUCTION 

 
 

 
David-Link Time Management System “DLTMS” will help the user to organize the company’s records in order, 

it is effortlessly, hassle free and can speed up the process of computing the timesheet in just a matter of seconds.  

 
DLTMS is design to accumulate company and employee’s profile then it stores and can make a synopsis print out 

copy of the spent working hours by each employee. With especial features which concede to post all the Leave 

availed, with OT Authorization settings and a lot more as we start to scan the content of this manual.  

 

HOW TO INSTALL THE DLTMS? 
 
The suggested software and system configuration needed to run the DLTMS (David-Link Time Management 

System) can be seen below: 

 

To install it in the Main Server  

 

• The OS used must be Microsoft Windows XP Service Pack 2,Windows Vista, and Windows 7 

• Intel (R) Celeron (R) CPU 2.13 GHz (the higher the better) 

• The Memory (RAM) must be 1 GB (minimum, the higher the better) 

• Hard Drive must be 80GB (minimum, the higher the better) 

 

To install it in the Client 

 

• The OS used must be Microsoft Windows XP Service Pack 2, Windows Vista, and Windows 7 

• Intel (R) Celeron (R) CPU 2.13 GHz (the higher the better) 

• The Memory (RAM) must be 256 MB (minimum, the higher the better) 

• Hard Drive must be 40GB (minimum, the higher the better) 

 

It’s time to install and setup the DLTMS in your PC. Just follow the simple guidelines for a quick and easy way in 

putting up the software. 

 

 

• Place the DLTMS Installer CD in your computer’s CD-ROM. 

• Double click on the setup.exe file. (If ever autoplay doesn’t functioning) 

• Click the Run button to start the installation. 

• Click Next to continue 

• Click Finish to start on the DLTMS program 
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SYSTEM’S MAIN FLOW 
 

 
The first thing to do is to arrange, create, and provide information of  

 

• Company Profile  

o Edit Info 

o Set Up 

� Department 

� Position 

� Work Status 

� Leave Type 

� Holiday 

 

o Users 

 

• Info Set-up 

• Employee & Posting 

o Time Card 

o Leave Application 

o Over Application 

o Change Day Off 

o Change Shift 

• Device Connection 

• DTR Process 

• Reports 

 

The Second thing is to set the device 

• Enroll Employees and administrator 

 

Next in line will be generating, processing a timesheet 

 

• Download  

• Auto Download Setting 

• Posting 

• Export 

o Employees Info 

o Transaction 

o Payroll 

• Import Data 

o Employees Info 

o Transaction 

• Report 

• Database Utility 
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 Log In is a security form which can 

only be unlocked by the authorized 

individual in able to access the 

system. 

 

 

STARTING UP WITH THE DLTMS 
 

 
To open the DLTMS, click the Start Menu then in the All Programs select the David-Link Corporation and 

click DLTMS 5. 5 or double click DLTMS 5.5 shortcut icon in the desktop. 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

Splash Screen is a form that loads and 

verifies the files and database of the 

system. 

Two Choices on How to input a Registration Key 

 

1. First Choice; 

1. Fill Up all the field provided 

2. Input the CD KEY that was given 

3. Click the Connect to Server and on the Status bar a message will appear 

either it is connected or not connected. If the message is connected it means 

you’re successfully connected to the server. 

4. Click the Generated key button 

5. After that click the Registration button to access the software. 

It’s the main interface of the 

system in which all the vital 

functions are establish 

sequentially. 

Index gives the user with a list 

of topics that may be used in 

operating the system as easy as 

it is. 

 

2. Second Choice: 

1. Click the Customer Service button, if you Choice this, contact your Service 

Provider for your Registration key or Click the DEMO key for 15 days trial. 

2. After inputting the registration key, click OK button to legally activate the 

software. 
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MENU MENU MENU MENU Some menus and submenus can only be accessed depends on the user type and privileges of the authorized 

end-user.  Hot keys - It gives you the chance to link through the DLTMS database in just using your keyboard. This 

uses a combination of keys from your keyboard. 

These menus and hot keys are as follows 

 

 
Instructions: 

1. Press the Alt key, then you’ll see the underline as shown in the above 

image. 

2. Key combination will be: Alt + F which opens the File Maintenance.  

3. If ever the submenus have hot keys, the press key will be: Alt + F + F 

which opens the Shift Setting. 

 

 

 

 

 

 

FILE MAINTENANCE 
    

    
NEW COMPANY NEW COMPANY NEW COMPANY NEW COMPANY allows you to add another company  

 

Instructions 

1. In the File menu, select Company 

2. Click New Company to add record 

       Fill up All the Filed 

• Enter the name of the company. Only fifty (50) 

characters are allowed. Then Provide the necessary 

information needed 

3. Key in the Company details in the provided field 

4. To activate a company’s records, select Open Company then select the 

desire profile. 

5. To delete a company, go to file menu then click Delete Company then 

choose company name w/c would you like to delete.  

6. If you want to close, then select Close Company. 

    
 

INFO SETINFO SETINFO SETINFO SET----UPUPUPUP 
In the View Menu Select the Info set-up sub Menu 

 

 

    
    
    
    
    
    

    5 
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1.1.1.1. Company Profile Company Profile Company Profile Company Profile     
    

    
    
    
    
    
    
    
    
    
    
    
Fig.1 Fig.1 Fig.1 Fig.1         COMPANY COMPANY COMPANY COMPANY collates all the list of company profile that is closely affiliated with another. 

    
Instructions 

1. In the View Menu, place the pointer in the Edit Info if you want to 

edit some of the information.  

2. Then Click Save. 
3. To set the company profile, click the Set Up. 

 

 

 

    
    
    

Fig 2.1 Fig 2.1 Fig 2.1 Fig 2.1 DEPARTMENTDEPARTMENTDEPARTMENTDEPARTMENT is used to create a department name within the company’s premises where an 

employee may belong. The grid shows the name and description of existing departments.    
    
Instructions: 

1. A form appears as shown at the middle, click New to add record 

2. To modify the profile, highlight the selected record then click the 

     Edit button 

3. To Search Department, just type the department code in the search  

     code box 

4. To delete a record, select a file then Click Delete button 

5. To ignore the changes made click the Cancel button 

 

Create new Department 

1. Provide the Department Code and brief description of the              

department you want to add in the field provided.  

2.  Click Save to save the created department and to add another.  

3.  Click Close button to close the window  

                                      4. Click Cancel button to ignore the department created and close the 

window.  

 

 

 

 

1 

2 

3 

Click View, Select Company profile. In the main menu 

click the EDIT INFO. See Figure 1  

Click View, Select Company Profile. In the main menu 

click the SETUP. See Figure 2.1-2.5.  

Click View, Select Company profile. In the main menu 

click the USERS. See Figure 3  
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Fig 2.2 Fig 2.2 Fig 2.2 Fig 2.2 POSITIONPOSITIONPOSITIONPOSITION   collects all the list of the respective work designation of each employee. 

    
Instructions: 

1. A form appears as shown at the middle, click New to add record 

2. To modify the profile, highlight the selected record then click the Edit 

button 
3. To Search Position, just type the position code in the search code box 

4. To delete a record, select a file then Click Delete button 

5. To ignore the changes made click the Cancel button 

 

Create new Position 

1. Provide the Position Code and brief description of the position 

you want to add in the field provided.  

2. Click Save to save the created department and to add another.  

3. Click Close button to close the window  

4. Click Cancel button to ignore the department created               

and to close the window.  

    
Fig 2.3 Fig 2.3 Fig 2.3 Fig 2.3 WORK STATUS WORK STATUS WORK STATUS WORK STATUS is composed of different kinds of employee’s rank, this may either sometimes Full 

Time/Regular, Probationary, Part Time, or Contractual 

    
Instructions: 

1. A form appears as shown at the middle, click  New to add 

record 

2. To modify the profile, highlight the selected record then click 

the Edit button 

3. To Search Work Status, just type the work code in the search 

code box 

4. To delete a record, select a file then Click Delete button 

5. To ignore the changes made click the Cancel button 

    
Create new Work Status 

1. Provide the Work Status Code and brief description of 

the Work Status you want to add in the field provided.  

2. Click Save to save the created department and to add 

another click New.  

3. Click Close button to close the window  

4. Click Cancel button to ignore the department created and to                     

close the window    
    
Fig. 2.4 Fig. 2.4 Fig. 2.4 Fig. 2.4 LEAVE OF LEAVE OF LEAVE OF LEAVE OF TYPE   TYPE   TYPE   TYPE   is the standard set of leaves that is used by the company. It allows the user to 

assign leave code with description and it indicates a number of leave within the year. The grid shows the leave 

code, description and number of leave per year of existing leaves 

 

Instructions 

1 A form appears as shown at the middle, click New to add record 

2. To modify the profile, highlight the selected record then click the 

Edit button 

3. To Search Leave, just type the leave code in the search code box 

4. To delete a record, Select a file then click Delete button 

5. To ignore the changes made click cancel button 
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Create New Holiday 

1. On the Leave Type Entry Form, Enter the leave type code, leave type name, and how many leave per 

year or per days. 

            2. Click the Save button to save the new record and to exit the form. 

3. Click the Save and New button to save the new record and to add another record. 

4. Ignore the changes made, click cancel button 

 

Fig 2.5 Fig 2.5 Fig 2.5 Fig 2.5 HOLIDAYS HOLIDAYS HOLIDAYS HOLIDAYS are made to place the remarkable dates that was declared by the company 

or by the government, which may be fall to Special Type or Legal Type. The grid shows the 

Holidays From, Holidays To, Holiday Description and Holiday Type. 

    
  Instructions: 

1. To add new holiday record click New Button. 

2. To edit Holiday records highlight the holiday name and 

click     Edit button. 

3. To Search Holiday, just type the leave code in the search 

code box 

4. To delete holiday record highlight the holiday name and 

click the Delete button. 

4. Click Cancel button to execute the program. 

 

Create New Holiday 

1. On the Holiday Entry Form, Enter the holiday name, 

holiday type and date  

2. Click the Save to save the new record  

3. Ignore the changes made, click cancel button. 

    
    

Fig.3 Fig.3 Fig.3 Fig.3 USER ACCOUNTUSER ACCOUNTUSER ACCOUNTUSER ACCOUNT is use to view the available users in the system.  There are two types of users in the 

system: Supervisor and User.  The Supervisor can access all of the features of the system.  The User has limited 

access of the system and sometimes needs permission of the Supervisor to access it. In Opening User account go to 

company profile on the right side select Users.  

    
    
    
    
    
    
    
    
    
Fig 3.Fig 3.Fig 3.Fig 3.1. NEW or ADDING NEW ACCOUNT1. NEW or ADDING NEW ACCOUNT1. NEW or ADDING NEW ACCOUNT1. NEW or ADDING NEW ACCOUNT    

    
Instruction:  

1. By clicking the new button, the above window will appear. 

User will be unable to login not unless he secures authorization 

from a Supervisor. Supervisor username and password should be 

key in to continue the chosen operation. 

2. Enter the user name that you want to create. Maximum of (10) 

characters are allowed for the user name.  

        

1 

2 

3 
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3. Enter the desired password for the user name.  Maximum of (10) characters are allowed.  

4. Re-enter the password for verification.  The re-entered password should match the desired password.  

5. Choose the User Type whether User or Supervisor.  

�  Supervisor – has a privilege to add, delete, edit  and  change the  software 

�  User – for viewing only 

 6. Click save button to save the user account made.  

 7. Click Cancel button to ignore changes made and to close the   window.  

 

Fig3.Fig3.Fig3.Fig3.2. CHANGING PASSWORD 2. CHANGING PASSWORD 2. CHANGING PASSWORD 2. CHANGING PASSWORD     
                                                                       Instructions: 

1. By clicking Change Password button, as on the above window           

will appear. User will be unable to login not unless 

 he secures authorization from a Supervisor. Supervisor 

username and password should be key in to continue the chosen 

operation.  

2. Enter valid password. Maximum of 10 characters.  

3. Re-enter current password for verification.  

4. Enter New Password. Maximum of (10) characters are 

allowed.  

5.  Click Save button to save the changes made on the 

password. If password change is successful confirmation 

message will be prompted otherwise password change     failure 

or password does not exist message will be prompted.  

 6. Click Cancel button to ignore the user account and to close 

the window.  

Fig . Fig . Fig . Fig . 3.33.33.33.3. REMOVING USER ACCOUNT . REMOVING USER ACCOUNT . REMOVING USER ACCOUNT . REMOVING USER ACCOUNT     
    

1. Choose the row of the user you want to delete then click on 

Remove User button.  

2. A message will be prompted. Click YES to delete the chosen 

user account or NO to ignore delete.  

    
    

    

Fig . 3.4Fig . 3.4Fig . 3.4Fig . 3.4. USER PRI. USER PRI. USER PRI. USER PRIVILEGE VILEGE VILEGE VILEGE     

Instructions: 

 

1. Click the privilege button to check and uncheck the 

privilege of the supervisor or the user 

2.  Click save button to save the changes made  

3.  Click close button to ignore the changes made 
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2. 2. 2. 2. SHIFTS SHIFTS SHIFTS SHIFTS It is an order list of daily time scheduled. Shift has two choices in making a schedule, the first one is 

Standard Shift which allows the user to set the Shift Time Setting - determines the start and end of the shift per 

day and the  Lunch Time Setting is to set the start and end of lunch break. Secondly, the user can set schedule by 

using a Flexible Shift – the start time is set in the system and the end time is at the discretion of the individual 

employee. In the File Maintenance Menu Select the Shifts sub Menu and the other one is under the Employees 

shortcut icon 

 

OR

              
 

 

 

 

    
    
1.1.1.1.    STANDARD SHIFT STANDARD SHIFT STANDARD SHIFT STANDARD SHIFT     

    
    
    
    
    
    
    
    
    
    
    

 

2. FLEXIBLE SHIFT2. FLEXIBLE SHIFT2. FLEXIBLE SHIFT2. FLEXIBLE SHIFT        
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Instructions: 
1. Click View or from the interface under Company Profile 

select the Shift Set Up.  

2. To set the new standard shift, Highlight the Shift 1 or 

any desirable number  and Click Edit Set Up to        set 

the time  

3. Set the Grace period on the provided field. (e. g. if the 

schedule time in is 8:00 then the set Grace min is 5 and 

the captured log was 8:03. The excess 3 min will not be 

considered as late unless the captured log was 8:06; the 

total late will be 6 min.) 

4. Click the short break setting button then set the Short 

Break  

5.  Click the Update button to save the changes                   

made 

6.   Click the Close button to ignore the changes made. 

     9 

Under the shift type, choose what shift 

you would like to set in your 

employee.  

9 
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Instructions: 

 

1. Choose the  Flexible Shift 

2. Select shift type this may either Daily which covers only a day to day schedule (time frame from 12:00 AM 

to 11:59 PM) or Cut-off that covers a certain pay period for an individual employee (time frame can 

capture anytime up to the next day) 

3.  Set the starting Log-IN time of the employee into the field provided 

4. Key in the Log int (interval) - it is the specified time (minutes) that will let the system get the next log. (e.g. 

5 minutes was the set interval. Time In: 8:00 the next time that can be captured will be 8:05) 

5. Input the vital Total hrs (Per Day) that the employee will render (i.e. Daily - 8, Cut-off - Weekly: 48, Bi-

Weekly: 96, Semi-Monthly:104, Monthly:208) 

    
EMPLOYEE EMPLOYEE EMPLOYEE EMPLOYEE PROFILE PROFILE PROFILE PROFILE Is use to keep employee information on the system. It can be sorted as to Department, 

Gender or All. The grid shows the list of employees enrolled in the system. In the File Maintenance Menu Select 

the Employees Profile sub Menu and the other one is under the Employees shortcut icon 

                     

                               

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Instructions 

1. Click the Employee & Posting 

3. A form appears as shown on the right, click [Add] to add record and provide the entire field that necessary. 

4. To modify the profile, highlight the selected record from the grid then click the [Edit].  

5. To start working with Search field Select Enroll No., Last Name, Department and the Active. After you select 

your desire field, you have select who/what you will search. 

6. To delete a record, highlight the selected record from the grid then Click the [Delete]. 

7. Click close button to close the window 
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Fields in the Employees Profile: 

 

1. Enroll Number  Shall be the same as what was registered enroll ID in the device. 

2. Employee Number  Is a unique identification of each employee which is assigned  

        by the company. If none, same as the enroll number may do. 

3. Employee Profile  Provide the necessary information on each field 

4. Work Info   Specified the each field with its corresponding information 

 

 
5. Load/Unload Picture This is to add and remove employee’s picture 

6. Days offs   Check the days in which an employee has no work 

7. Exemption   For lates and/or early leave 

8. Active   To identify if the employees is still connected to the company  

otherwise uncheck if its no longer connected to the company 

9. Save and New  Stores the employee’s record and add another profile 

10. Save and Close  Saves the employee’s record and close the window 

11. Cancel   Ignore all the changes made without saving the data. 

 

 

 

 

 

 

PROCEDURE ON HOW TO ENROLL EMPLOYEE’S TO DEVICE 

 

 

1. Press the menu 

2. Choose Data Proc / Enroll, then Press OK to continue 

3. Choose User / User Reg., then Press OK to continue 

• Fingerprint          

•   Fingerprint/Password 

• Password 

4. NOTE: Enrolling Admin / Manager is same procedure with the user 

12 
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Fingerprint Password Fingerprint / Password 

Procedure on how to Enroll 

Employee’s using Fingerprint 

 

1. Select Fingerprint then Press 

OK to continue 

 

2. New Enroll the following 

message will appear on the 

display then Press OK to 

continue 

 

3. ID number the following 

message will appear on the 

display,  input the desired  ID or 

Enroll number (Range 1-65534) 

then OK to continue 

 

4. Press Finger the following 

message will appear on the 

display, Place the finger 3 

consecutive times then press 

OK to continue. To cancel the 

enrollment press ESC 

 

5. Continue the following 

message will Appear on the 

display, Please press [OK to 

save] or [ESC to cancel the 

enrollment] 

 

Enroll Back-up fingerprint 

 

6. New Enroll press ESC then 

press OK to continue. 

Maximum of 3 back-up is 

allowed. 

 

7.  Repeat   Step 3 to 5 

 

8. Click OK if you want to 

create another backup 

fingerprint. Press ESC to if you 

want to go back to the main 

menu 

 

Procedure on how to Enroll 

Employee’s using Password 

 

1. Select Password then Press 

OK to continue 

 

2. New Enroll the following 

message will appear on the 

display then Press OK to 

continue 

 

3. ID number the following 

message will appear on the 

display, input the desired ID or 

Enroll number [Range 1-65534] 

then press OK to continue 

 

4. PWDIn the following 

message will appear on the 

display – input the desired 

password then press OK to 

continue 

 

5. CONfm the following 

message will appear on the 

display – Retype password then 

press OK to continue to save. 

To cancel the enrollment press 

ESC 
 

Note: The password range is 

from1 to 5 digits only. 

 

6. Continue the following 

message will appear on the 

display then Press [OK to save] 

or [ESC to cancel the 

enrollment]  

 

7. Click OK if you want to 

create another enrollment. Press 

ESC to if you want to go back 

to the main menu 

Procedure on how to enroll 

Employee’s using Fingerprint / 

Password 

 

1. Select Fingerprint / 

Password then Press OK to 

Continue 

 

2. Repeat the procedure of 

Fingerprint and password 
from the left beside 
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EMPLOYEE POSTING 
 

             

1.1.1.1.    TIME CARDTIME CARDTIME CARDTIME CARD   shows the logs of every employee for a particular date range. The grid shows the logs 

entered in the system for the chosen date range together with other information like the device number and the 

enroll number of the device; username of the employee are also included. One log is equal to one transaction.    
 

Instructions:  

1. User will be unable to login not unless he secures authorization 

from a Supervisor. Supervisor Username and password should 

be key in to continue the chosen operation. 

2. Set first the Date range, to show you the accurate transaction 

you only want to view.  

3. Select an Employee’s name or ALL to get the specific time 

he made    

4. Creating latest transaction click new button, then a popup 

menu shows. The chosen employee name will be 

automatically being displayed in the Name field; this can’t 

be deleted or edited unless you want to change the name just 

click Cancel button to ignore the activity. So after you type 

in the details in the transaction entry you can now see the 

result in the grid directed by the arrow.  

5. Specify the applicable date to be added within the logs 

6. Specify the accurate time  

7. Under Flexible Shift, Rule In/Out Mode, identify if the log is under CI (Check In), CO (Check 

Out), OFL (Out for Lunch), IFL (In from Lunch), OTI (OT In), or OTO (OT Out).  

8. Indicate the remarks for the log. 

9. Click Save and New button to save the log made and to create another one.  

10. Click Save and Close button to save the log made and to close the window.  

11. Click Cancel button to ignore all the changes made.  

12. To delete a log, select an employee to be able to view his/her logs. From the list of logs, 

highlight the specific logs you want to delete. If you want to delete all the logs just click 

DELETE ALL button. 

2. 2. 2. 2. LEAVE APPLICATIONLEAVE APPLICATIONLEAVE APPLICATIONLEAVE APPLICATION Can only be access by the supervisor. It is use to grant permission for 

leave by a requesting employee.  The grid shows the employee who requested for a leave and the date 

range of the request. Be sure that you have input your company’s leave type in the Leave Form; this 

can be found in File Maintenance Menu, info set-up then select Leave type. 

Instructions 

1. User will be unable to login not unless he secures authorization 

from a Supervisor. Supervisor Username and password should be 

key in to continue. 

2. On the Entry Date field, enter the date the request was 

approved. 

3. Proceed to Employee Name section, search for the employee's 

name who request for leave. After retrieving employee's name, the 

Employee No and Enroll No are automatically retrieved as well. 

4. On the Time Range field, enter the date range of the application 

in the FROM as the starting date and TO as the end date of the 

leave.  

 5. On the Count As field, specify if the leave in the Time            

Range is WD for whole day or HD for half day.  

                                                               6. On the Leave Type field, select the type of leave  
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7. The reason why the leave was applied for should also be indicated.  

8. Click Save and New button to save the leave application and to create another one.  

9. Click Save and Close button to save the leave application and to close the window. 

10. Click Cancel button to ignore all changes made and to close the window.    
    

3. Overtime Application3. Overtime Application3. Overtime Application3. Overtime Application can only be access by the 
supervisor.  It is use in authorizing an employee who is 

requested to work over time.  The grid shows the type of 

Over Time Code, which is computer generated that shows 

the employee who is requested to work over time. The 

range of date and the reason for over time for that range of 

date is also shown. 

Instructions:  

1. User will be unable to login not unless he secures 

authorization from a Supervisor. Supervisor username and 

password should be key in to continue the chosen operation. 

2. On the Select Department field, specify the department of the employee who is requested 

to work overtime.  

3. On the Name field, search for the name of the employee with the use of the following 

information, last name, first name, middle name and enroll number.  

4. When the name was retrieved, click on the Select button to add the First Name, Last 

Name, Middle Name and Enroll Number of the employee to the grid.  

5.  Click all buttons to add all employees to the grid.  

6. In Deleting All the record listed, right click on the grid then this image with condition to Delete All 

the listed Names, to ignore it just press ESC. 

7. Choose date range for the over time.  Click on FROM to set the starting date and TO for the end date. 

8.  Reason for overtime work should also be indicated. \ 

9.   Specify the start and end time of the overtime on the specified date range.  

10. Click on the Save button to save over time authorization.  

11. Click on the Close button to ignore changes made and to close the window.  

 

 

4. 4. 4. 4. CHANGE DAYCHANGE DAYCHANGE DAYCHANGE DAY----OFFOFFOFFOFF this Form lets the user to make an adjustment with their rest day schedule. 

    
Instructions 

1. In the File Maintenance menu, place the pointer in the Employee 

Posting then click Change Day off 

2. Key in the employee’s name in the search field to be able to find it 

easily  

3. Select All or a certain department desired then check the box to check 

all the name of the employee. 

4. Select a list of employee whom to apply the new set of day/s off 

5. Click the chosen day/s from the calendar to set the latest  

6. Click the chosen day/s when does the employee/s will be having an off. 

7. Click the Set default button to apply the standard day off set per 

employee. 

  8. Click Update button to save the transaction 

9. To ignore the changes made without saving click the close button 
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5.5.5.5.    CHANGES SHIFTCHANGES SHIFTCHANGES SHIFTCHANGES SHIFT    Is use to adjust the existing shift of an employee for a certain range date and 

time. Changed shifts can be sorted out by choosing from and to date.  After choosing the date range, 

changed shift information grid will let you view the restored shift under the chosen date range. 

 

Instructions 

1. By clicking the new button from Changes Shift form, pop up 

window will appear. User will be unable to login not unless he 

secures authorization from a Supervisor. Supervisor username and 

password should be key in to continue the chosen operation. 

2. Changing the employee’s shift, select the Department and the 

Name of the employee.  

3.  Click Select button to add the name of the employee to the grid 

or click ALL to add all employees to the grid. 

4.  In Deleting all the record listed, right click on the grid  

then this imge                   -will pop up with condition to 

Delete All the listed Names. To ignore, just press ESC.  

5. Check the Shift Rule Enable to change the shift date and 

time.  

6. Select the date and time of the start and end of the shift-

change.  

7. Check the Lunch Rule Enable to change the lunch time for 

the changed shift date.  

8. Key in the Start and End time for lunch break 

9. Click Save button to save the shift change made or click 10 

10.Close button to ignore shift change made and to close the 

window. 

                  

 

Download DL-Series  
 

 

 

                 

 

 

 

 

 

 

 

 

 

 

Instructions: 

1. There are two ways in opening the Device Connection form. In the View Menu Select the Device Connection 

sub Menu and the other one is under the Main shortcut icon. 

2. Click the arrow down to select the device model 

3. Click OK. 
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    SETTING THE DEVICESETTING THE DEVICESETTING THE DEVICESETTING THE DEVICE 
 

Instructions:  

1. Click the Setting button and the window above will appear.  

2. Select or Type in the proper Machine Number of the device 

3 Tick Serial Device for connecting the device directly to the user’s 

PC, select the ComPort and Baud Rate of the device. (For DL-

Series)Select the Comport number among one (1) to eight (8). 

Select Baud rate, Select whether it’s 115200, 38400 or 9600 NOTE: 

Make sure the Baudrate of your computer, software and your device 

are they the same. 

 

� Procedure to set the baudrate to the Computer:  
              

• Go to Start Menu 

• Click my computer then right click the mouse 

• Select the Manage 

• From the Computer Management (Local), Select the Device Manager then double click 

•  From the right side double Click the Ports (COM & LPT) 

• Select the Port Setting from the Bits per second then Choose the Baudrate that they same with 

the device and to the Software. 

• Click OK button 

 

  4. Select the Machine number. The device number it depends on the device selected. 

  5. Tick Network Device (Local Area Network Connection) in using a shared connection with the device 

within the vicinity, key in the IP Address & Port Number. (For DL-Series ) 

• Input the desired IP address of your device 

• Input the Port Number [Default number 5005] 

6. Select the appropriate unit model 

7. Click the Save button to save all changes made.  

8. Click the Close button to ignore all changes made and closes the window.  

9. Thick the USB device, if your using USB cable, then click save. 

CONNECTING TO THE PCCONNECTING TO THE PCCONNECTING TO THE PCCONNECTING TO THE PC    SERVERSERVERSERVERSERVER 

PC Server provides a full access of the device even at a certain distance. This is an easy way in monitoring 

every transactions made by an individual on a day to day basis in just a click on your own work station. It’s 

standard to have a WAN or Internet connection on the PC for a fast link. Here are ways on how to connect on 

the device: 

Server: 

1. Install the Remote Server on the Computer where the device is connected.  

Client: 

1. Install the DLTMS  

2. Click the Start Menu then point on the All Programs. Look for David-Link Corporation and open the 

DLTMS 

3. In the Tools Menu Select the Download sub Menu and the other one is under the Utilities shortcut icon 

4. Click Settings button then tick the PC Server. Key in the appropriate IP address of the Server where the 

device is connected and key in the assigned Server Port number. 
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CONNECT TO THE DEVICECONNECT TO THE DEVICECONNECT TO THE DEVICECONNECT TO THE DEVICE    
 

Instructions: 

 
1. Click the Connect button 

2. If connected, “Connected” this message will appear 

3. If not connected, “Not Connected” this message will appear 

4. If the device not found, its better check the connectivity if it’s properly in place or it was not loosen its 

connection or If you hear any sounds on the device try to check the baudrate of your device, software and to 

your computer. 

 

LOGS IN THE DEVICELOGS IN THE DEVICELOGS IN THE DEVICELOGS IN THE DEVICE    
 

Instructions: 
 

1. Click the Read Logs button to view all logs that are stored in the device 

2. Click the Update Logs button to transfer logs from the device to the system 

3. Click the Clear Logs button to delete all logs in the device. This function is useful especially when the logs 

stored in the device is almost full. 

 
SETTINGS THE DEVICE TIMESETTINGS THE DEVICE TIMESETTINGS THE DEVICE TIMESETTINGS THE DEVICE TIME    
 

 Instruction: Click the Time Sync Button to make the Device Time and Device Date synchronized to the 

computer 

 

DEVICE TOOLSDEVICE TOOLSDEVICE TOOLSDEVICE TOOLS     
1. The Device Info button shows total number of administrator, users, and logs stored on the device.  

2. The View Device setting button views the settings made in the device.  

3. The System setting button controls the setting of the device. 

4. The Message Setting is made to send information to a certain employee. The message can be seen once 

the user log in the device and this can be viewed one time. 

5. All Back-up/Restore Fingerprint to back-up and restore all the data from the device  

6. Individual user Fingerprint button to make a back-up fingerprint. 

 

a. DEVICE TO SYSTEM 

• Select the Device   

• Click load form button to access the entire fingerprint on the device 

• To save the fingerprint highlight all record from the grid then click Save to button to 

save on the system.  

b. SYSTEM TO DEVICE 

• Select the USB format  

•  Click the load form button  

• Locate the file then select the Device 

• To save the files to device click the Save to button.  

c. To delete the fingerprint, Click Load Form then highlights all the record from the grid then 

clicks the Delete button. 

d. To close the window click the X 

       7.  Click Update User Data button to change the Privilege of the user or manager.  

� process of saving the changes made within the user’s data such as Privileges, Name, then it can also set 

a message and lastly it allows to change the user status into Enable or not. 

• Click Read Enroll Data to collect all the user and manager.  

• To Change the Privilege of the user or manager highlight the selected record from the grid then 

check the check box 
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• Select Privilege to change the user or manager and then click Update button. 

• To close the window Click Close. 

8. The Read Manage Device Log button monitors all transactions made by the manager 

9. The Delete Device Log button deletes all the transactions made by the manager 

10.  Device Status button ensures the status of the device. Checks the Enable checkbox if the device is still 

active, otherwise uncheck it.  

11. Click the Close button to close the Device Tools window 

DISCONNECTING THE DEDISCONNECTING THE DEDISCONNECTING THE DEDISCONNECTING THE DEVICEVICEVICEVICE    

Instructions: Click the Disconnect button to disconnect the device from the system. 

DOWNLOAD WDOWNLOAD WDOWNLOAD WDOWNLOAD W----SERIESSERIESSERIESSERIES 
 

 

    
    
    
    
    
    
 Instructions: 
1. There are two ways in opening the Device Connection form. In the View Menu Select the Device Connection 

sub Menu and the other one is under the Main shortcut icon. 

2. Click the arrow down to select the device model 

. Click OK 

                                                SETTINGS THE DEVICESETTINGS THE DEVICESETTINGS THE DEVICESETTINGS THE DEVICE    
 
Instructions: 

1. Click the Setting Button and the Window beside will appear. 

2. Choose The Connection Type, Serial device, Network device or USB device.  

• Serial Device is directly used to connect the device to the computer.  

• Tick Network Device (local Area Network Connection) in using a shared connection with the 

device within the vicinity, key in the IP addresses & port number. 

       3. Tick USB connection to connect to the device directly to the            system                   

       4. Select the Comport number among one (1) to eight (8).  

       5. Select the Machine number. The device number it depends on    the device selected. 

3. Select Baud rate. Select whether it’s 115200, 38400 or 9600. 

4. Click the Save button to save all changes made. 

5. Click the Close button to ignore settings made or to close the window. 

NETWORK DEVICE 

 

 

 

    

OR 

16 
17 

19 

17 

19 1. Under the Device , Select  W-Series (W988 ,W988PB,W1288,W1288PB)  

2. Select the Device No.  Among one (1) to eight (8). 

3. Thick the Network Device  

4. Input the IP Address  that you enter in the device \ 

5. Input the Port no. of the device  

Click Save 

6. System Message will appear , Click OK  
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LOGS IN THE DEVICELOGS IN THE DEVICELOGS IN THE DEVICELOGS IN THE DEVICE 

Instructions: 

1. Click the Read Logs button to view all logs that stored in the device. 

2. Click the Update button to transfer the logs from the device to the system 

3. Click the Clear Logs button to delete all logs in the device. This function is useful especially when the 

logs stored in the device is almost full. 

TIME SYNCTIME SYNCTIME SYNCTIME SYNC    
Instructions: 

1. Click the Time Sync if you want  your pc time is the same in your device  

2. Click OK  

 

 

DEVICE TOOLSDEVICE TOOLSDEVICE TOOLSDEVICE TOOLS    
 
Instructions:   

1. Click Device Info button show total number of administration, user, logs stored on the device. 

2. Click View Device setting button to view the settings made in the device. 

3. Click System Setting button this is made to send information to a certain employee. The message can 

be seen once the user log in the device and this can be viewed one time. 

4. The Message Setting is made to send information to a certain employee. The message can be seen once 

the user log in the device and this can be viewed one time. 

5. Click User Data button to make a back-up fingerprint. 

a. DEVICE TO SYSTEM 

• Select the Device   

• Click load form button to access the entire fingerprint on the device 

20 

1. Double Click the W-series ,Device 

No. etc   

 CONNECTING TO THE DEVICECONNECTING TO THE DEVICECONNECTING TO THE DEVICECONNECTING TO THE DEVICE    

Instructions: 

1. Click the Connect button. 

2. If connected, “Connected” message will appear. 

3. If not connected, “Device not found” message will 

appear. 

4. If the device not found, its better check the IP Address 

of software and your computer.... 
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• To save the fingerprint highlight all record from the grid then click Save to button to 

save on the system.  

b. SYSTEM TO DEVICE 

• Select the USB format  

•  Click the load form button  

• Locate the file then select the Device 

• To save the files to device click the Save to button.  

c. To delete the fingerprint, Click Load Form then highlights all the record from the grid then 

clicks the Delete button. 

d. To close the window click the X 

6. Click Update User Data button to change the Privilege of the user or manager.  

� process of saving the changes made within the user’s data such as Privileges, Name, then it can also set 

a message and lastly it allows to change the user status into Enable or not. 

 

• Click Read Enroll Data to collect all the user and manager.  

• To Change the Privilege of the user or manager highlight the selected record from the grid then 

check the check box 

• Select Privilege to change the USER to MANAGER or MANAGER to USER and then click 

Update button. 

• To close the window Click Close. 

 

7. The Read Manage Device Log button monitors all transaction made by the manager 

8. The Delete Device Log button deletes all the transaction made by the manager. 

9. Device status button ensures the status of the device. Checks the Enable checkbox if the device is still 

active. Otherwise uncheck it. 

10. Click Close button to close the Device Tools Window 

REAL TIMEREAL TIMEREAL TIMEREAL TIME----    directly shows the logs in the software upon log in and out.  

        Settings in the Settings in the Settings in the Settings in the Device Device Device Device     

1. Under The device you need to set first the SERVER IP or the IP address of your PC  

2. Select Menu, Select Set Comm., Select Ethernet, Arrow Down (    )  

3. Select Server IP, Select [OK] Input your IP address (192.168.1.012) and check the Serport No.  

    
    
Settings in the Software Settings in the Software Settings in the Software Settings in the Software     
    

    

    

    

    

    

    

    

1 

2 

3 

5 
6 
7 
8 

4 

Instructions:  

1. Input the Host Port  

2. Click Open network ,Then log in in 

the device  

3. In the Time card it will display your 

actual logs  

4. If you finished log in the device  

5. Click Close Network  

6. If you want to clear all logs in the 

timecard , Click Clear List  

7. Then Close the form  
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DISCONNECTING THE DEVICEDISCONNECTING THE DEVICEDISCONNECTING THE DEVICEDISCONNECTING THE DEVICE    

Instruction: Click the Disconnect Button to disconnect the device from the system. If Disconnected 

“Disconnected message will appear 

 

 

 

DOWNLOAD DS-777 (Face scanner)  
 

 

 

    
    
    
    
    
    
    
 

 

Instructions: 

1. There are two ways in opening the Device Connection form. In the View Menu Select the Device Connection 

sub Menu and the other one is under the Main shortcut icon. 

2. Click the arrow down to select the device model 

. Click OK 

                                            SETTINGS THE SETTINGS THE SETTINGS THE SETTINGS THE SOFTWARE SOFTWARE SOFTWARE SOFTWARE     
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fields in the Employee Profile 

1. Display the basic information of the Employee and show the picture also. 

2. It shows duplication of entry  

3.  Shows the logs of the employee who log in and log out in the device  

4. Total logs of the device  

5. Host Port of the Device  

6. Open your IP Address in the PC  

7. Close Network 

8. Clear logs in the software  

OR 

Instructions:  

1. Select Device Connection  

2. Under the Device ,Click Arrow Down (  ) 

Select DS777, Device No. 1) 

3. Input the IP address ( the same in the IP address of 

the face scanner) 

4. Input the Port No ( the same in the IP address of the 

face scanner) 

5. Click Save  

6. Under the time card double click the 

DS777. 
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LOGS IN THE DEVICELOGS IN THE DEVICELOGS IN THE DEVICELOGS IN THE DEVICE 

Instructions: 

4. Click the Read Logs button to view all logs that stored in the device. 

5. Click the Update button to transfer the logs from the device to the system 

6. Click the Clear Logs button to delete all logs in the device. This function is useful especially when the 

logs stored in the device is almost full. 

7. Click Read Image button to view all images that stored in the device. 

TIME SYTIME SYTIME SYTIME SYNCNCNCNC    
Instructions: 

3. Click the Time Sync if you want  your pc time is the same in your device  

4. Click OK  

 

    
                                                                                                                                                                                                        DEVICE TOOLSDEVICE TOOLSDEVICE TOOLSDEVICE TOOLS    
 

 

 

 

 

 

 

 

 

 

 

 

 

1.1.1.1. Device InformationDevice InformationDevice InformationDevice Information    
 
The Device Info button shows total number of User Count, Template 

Count, and logs and Image stored on the device.  

 

Instructions: 

1. Click Tools , Select Device Information  

2. Click Ok  

3. Click close  

 

 

1. Click Connect Button on the 

right side 

2. Click OK  

20 
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2.2.2.2. User Information User Information User Information User Information     

The User Information shows Enroll no. enrolled in the device, 

Type, Card No and Name.  

Instructions:  

1.  Click Tools , Select User Information 

2. Click OK 

3. Click Close 

 

 

3. Door Access control Door Access control Door Access control Door Access control     

Time Zone – To set Shift Setting of the Employee. 
To edit the Time ZONE  
Just set the shift setting of the device 
Input the desired no. you want to set up.  Press [OK]  

• Time Zone > 01     Shift  
Note: Range Shift 1- Shift 50 
 
To edit the time everyday , just select the desired day of the employee you want to 
set .  Click arrow down (     ) and  arrow up (      ) to change the time.  
Click Read , then Update if you finished . 
 

 
Group Access 

 
Ex. In one group you can set 3 time zone [TZ 1, TZ 2, TZ 3] 
Group 1  set in TZ 1, TZ 2 and TZ 3 
User/Employee that  assigned in Group 1, can only Access in the  
door base in the  TZ1, TZ2 and TZ3  

 

 

 

User Account 

- Assigning of Employee/User in a group 

It looks like defined Group TZ but this one is for individual user, 
once you assigned the user/employee in a group. There’s a 
specific time for the User to  access the door 
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Access Comb 

Virtual Time Card Virtual Time Card Virtual Time Card Virtual Time Card show the list of process every transaction made like list of logs with calculated hours 

worked rendered by each employee on a certain period of time. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Functionalities: 
1. Under Virtual Time card, select Shift Type is a category that will let you select the standard shift or the 

flexible shift. 

2. Select Department is a category that will let you select one or all the department available. 

3. Select Employee is a category that will let you select one or all the employee available. 

4. Shows only a specific transaction covered only by the monthly or semi-monthly 

5. Process is an action made to prepare to load the required data 

6. These are the transaction that we process 

 

 

 

 

 

 

 
                                                                                                                                                                     . 
 

 
 

 
                                                                                      

 
 
                                                  
                                                         DTR PROCESS 

 
                                                        

1 

2 

3 

5 

6 

21 

21 

4 

Input the desired enrolled no.  
Displays who are the Users can access only the door lock to open 
Individual user can access or combination of Users 
Enter the desired enroll no. combination you want. 
(Maximum of 5 digits) 
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                                                                     REPORT 
 

 

REPORTSREPORTSREPORTSREPORTS show the list of every transaction made like timesheets, attendance, and list of logs with calculated 

hours worked rendered by each employee on a certain period of time.  

 

    
    
1. LISTING REPORT1. LISTING REPORT1. LISTING REPORT1. LISTING REPORT    is the master list of all employees that are enrolled in the system 

� Department List 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Functionalities: 

 

1. Under Select a type of report Select Listing Report Department it compiles all the department’s record 

2. Under Available report Department List, Select Department is a category that will let you select one or 

all the department available. 

3. Preview allows you to see the  actual report before printing it out 

4. Export allows you to see the reports in excel format 

5. Close the window and can proceed to the other features 

 

 

� Employee Master List 
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Functionalities: 

 

1. Under select a type of report Select Listing Report Department it compiles the entire department’s 

record 

2. Under Available report Department List Select Employee master List is a category that will let you 

view all the employee. 

3. Under the Department, select what department does the employee belong, and also what employee 

name you want to view 

4. Preview allows you to see the actual report before printing it out 

5. Export allows you to see the reports in excel format 

6. Close the window and can proceed to the other features 

 

� Holiday List 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Functionalities: 

 

 
1. Under select a type of report Select Listing  

2. Under Available report Department List Select Holiday List is a category that will let you view all the 

holiday.  

3. Preview allows you to see the actual report before printing it out 

4. Input what year you want to view 

5. Close the window and can proceed to the other features 

 

� Leave Type List 
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Functionalities: 

 
1. Under Select a type of report Select Listing Report Under Available report Leave Type List   

2. Select Leave type list is a category that will let you view how many leaves did you used or available. 

3. Preview allows you to see the actual report before printing it out 

4. Print it will let you print out the result. 

5. Close the window and can proceed to the other features 

 

 

� AUDIT TRAIL  

 

 

 

 

 

 

 

    
    
    
    
    
    

 

Functionalities: 

 
1. Under Select a type of report Select Listing Report Under Available report Audit trail   

2. Select Audit trail is a category that will let you view who made all the transaction. 

3. Enter the date you want to view who made the transaction  

4. Preview allows you to see the actual report before printing it out 

5. Print it will let you print out the result. 

6. Close the window and can proceed to the other features 

    
2. DAILY REPORT2. DAILY REPORT2. DAILY REPORT2. DAILY REPORT is use to view the time record and employee attendance for a specific date.     
 

 

 

 

 

 

 

 

 

Functionalities: 

 
 1. Daily Report refers for a day to day basis, can show transaction for only one employee in specific day. 

 2. In Available reports, Select who’s in, who’s out, and whose half day. Allows the user to show all the            

employees time in that particular day  

 3.  Date shows only a specific transaction covered only by the set day 
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 4.  Preview allows you to see the actual report before printing it out 

5. In Available reports you can select who s in,  

6.  Print it will let you print out the result. 

 7.   Close the window and can proceed to the other features 

    
    
3. MONTHLY 3. MONTHLY 3. MONTHLY 3. MONTHLY RRRREPORTEPORTEPORTEPORT    is use to view all transactions that occur in a month. The report shows necessary 
information of the company such as a DTR (Detailed) Standard, DTR (Detailed) Flexible, Employee Payroll 

Report, Late Summary, Under Time Summary, Over Time Summary, Missing Clock in/Out Transactions, 

Leave of Absence List and Absent List. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Functionalities: 

 

1. Monthly refers for monthly basis, can show transaction for on. 

2. Available Report 

DTR (Detailed) Standard has a special feature that follows your company’s requirement. It 

collates and monitors the logs of each employee, and aside from this it has characteristic that 

shows an automatic computation of all the activities done for a certain time.  

 

DTR (Detailed) Flexible shows the real time transaction made by the employees with an 

automatic computation of all the activities done on a certain time. 

Late Summary displays how many times an employee have been late 

Under Time Summary reflects how many hours of under time the employee has 

Over Time Summary reflects how many hours of over time the employee has 

Missing clock In/Out Transactions shows the transaction with missing punch 

Leave of Absent List shows the list of employee that on leave 

Absent List will show the List of employees that are absences on the specific date chosen 

    

                                                                     Utilities 
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DATABASE DATABASE DATABASE DATABASE TOOLS  TOOLS  TOOLS  TOOLS   is used to import old record, backup, restore, purge and initialize the database of the 

system.  It is done so that the transferring of data is easier and no data will be lost. In the Tools Menu Select the 

Database Utility sub Menu and the other one is under the Utilities shortcut icon 

 

      

1. BACKUP DATABASE1. BACKUP DATABASE1. BACKUP DATABASE1. BACKUP DATABASE is used to create a copy of the current database to be stored in a specified 
folder to be restored to a different computer station or for record keeping.    

 

Instructions:    

1. Choose the Backup option.  

2. Select the drive and the folder where you want to backup 

the database.  

3. Enter a Filename for  

4. Click BackUp button to start the backup process. User will 

be unable to login not unless he secures authorization from a 

Supervisor. Supervisor username and password should be key 

in to continue.  

5. Click Close button to close the Database Utility window. 

 

 

 

 

 

 

 

 

 

2. RESTORE DATABASE2. RESTORE DATABASE2. RESTORE DATABASE2. RESTORE DATABASE is used to retrieve the backup database that came from another working 

station.  It is useful especially in times of data lost.  

 

Instructions:  

1.  Choose the Restore option.  

2. Select the drive and the folder where the backup of the 

database is located.  

3. Choose from the list the name of the database to be 

restored. 

4. Click Restore button to start the restoration process.  The 

Log In screen will appear unless you are a Supervisor. 

Provide the Supervisor User Name and Password to 

continue.  

5. Click Close button to close the Database Utility window.  
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EXPORT DATAEXPORT DATAEXPORT DATAEXPORT DATA transfers data from the system database to text document format (TXT) or excel format 

(CSV).  Once the data are exported, it can be imported to another system that uses the same data.  Data that can 

be exported are employee information, transactions, and payroll.  Exporting data can only be accessed by the 

Supervisor.  

 

                                                        

 Instructions:    
1. Select the date hired of data to be exported. FROM as the starting Date and TO 

as the end date. 

2. Select the File format then click Excel Format (CSV) 

3. Select the drive and directory where you want to save the file.  

4. Click the Export button to start the transfer of data in the file created.  

5. Click Close button to close the window and ignore exporting of data. 

 

 

 

 

 

Instructions:    

1. User Sort by to arrange data alphabetically or in numerical order 

Select the date range of data to be exported.  FROM as the starting date  

and TO as the end date.  

2. Select the File Format whether Text Document Format (TXT) or 

Excel Format (CSV). 

3. Select the drive and directory where you want to save the file. 4. 4. 

Click the Export button to start the transfer of data in the created. 

 4. Click Close button to close the window and ignore exporting of                          

data

  Employee’s Profile 

Transaction 

Instructions:     

1. Select the File Format   Excel Format (CSV). 

2. Select the drive and directory where you want to save the file. 4. 3. 

Click the Export button to start the transfer of data in the created. 

4. Click Close button to close the window and ignore exporting of              

data 
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IMPORT DATAIMPORT DATAIMPORT DATAIMPORT DATA is used to restore the exported data to be used by the system.  Data imported will be added in 

the system and the present data will not be lost.  Data that can be imported are employee information and USB 

transactions as well. Importing data can only be accessed by the Supervisor.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Instructions: 

 

1. Click Browse button to locate the exported data in its specified location.  

2. Click Import button to start the importing of data in the system database.  

3. Click Close button to ignore the importing of data and close the window.  

 

 

 

 

 

 

 

 

 

 

 

Employees Info and USB Transaction [DL-

SERIES / W-SERIES / DL-777] 
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